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Preface 

Introduction 

Welcome to the Hi-Target HGO data post processing software. This introduction describes how 

to use this software to do systematic static GPS data processing, for better baseline vector 

solution results. 

Experience Requirement 

In order to help you use the Hi-Target HGO data post processing software better, we suggest you 

carefully read the instructions. If you are unfamiliar with the software, please refer to 

http://www.hi-target.com.cn/ 

Tips for Safe Use 

Notice: The contents here are special operations and need your special 

attention. Please read them carefully.  

 

Warning: The contents here are very important. Wrong operation may 

damage the machine, lose data, break the system and endanger your safety.  

Exclusions  

Before using the product, please read these operating instructions carefully, they will help you 

to use it better. Hi-Target assumes no responsibility if you fail to operate the product according 
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to the instructions, or operate it wrongly, due to misunderstanding the instructions.  

Hi-Target is committed to constantly perfecting product functions and performance, improving 

service quality and we reserve the right to change these operating instructions without notice.  

We have checked the contents of the instructions, the software and hardware, without eliminating 

the possibility of error. The pictures in the operating instructions are for reference only. In case 

of non-conformity with products, the products shall prevail. 

Technology and Service 

If you have any technical issues, please call Hi-Target’s technology department for help.  

Relevant Information 

You can obtain this introduction by:  

1. Purchasing Hi-Target products: you will find this manual in the instrument container to guide 

you on operating the instrument.  

2. Logging onto the Hi-Target official website, downloading the electronic version introduction 

at Partners → Partner center.  

Advice 

If you have any comments and suggestions for this product, please email info@hi-target.com.cn. 

Your feedback will help us to improve the product and service. 
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1.1 Installation 

1.1.1 Software Installation 

The HGO software requires at least 1GB of RAM and 500MB of hard disk. Applicable 

environments are as follows: 

- Microsoft ® Windows NT Service Pack 4 or higher 

- Microsoft ® Windows XP/7/8 

- Microsoft .Net Frameworks 2.0 

Run the corresponding .msi file, follow the steps to set up, and click Next until the installation is 

complete. 

 

Figure 1-1-1 Installation 



HGO User Manual  

3 

1.1.2 Software Register 

When you start the software for the first time, you will be prompted with Software Unregister! 

If you don’t register, the PPK and the advanced baseline solution engine won’t be available, and 

you will be reminded to register every time you restart the software;: other functions are free to 

use. 

 

Figure 1-1-2 Register 

 

1.2 Quick Start 

This chapter explains the HGO data processing software solution, through an example. It enables 

users to quickly understand how to use the software. For more detailed and advanced usage, 

please see the following sections. 

1.2.1 Static GPS Data Processing 

The general procedure of static GPS data processing: 
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- Create a new project, and set up the coordinate system; 

- Import data, and edit file antenna high information; 

- Get the baseline solution, and adjust according to the residual information until the baseline 

quality is qualified; 

- Do the network adjustment, after inputting the control point information, complete the free 

network adjustment → 84 constraint adjustment → local three-dimensional or two-dimensional 

constraint adjustment; 

- Export various solution reports. 

1. Create a new project 

 

Figure 1-2-1 Create A New Project 

Select File → New to enter the New Project interface. Input the project name, select the folder 

where the project is stored, and click OK to complete the creation of the new project. 
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2. Project property modification 

 

Figure 1-2-2 Project Properties 

After setting the project name and working directory, it will automatically pop up the Project 

Properties setting interface; users can set the details of the project, including Information, 

Tolerance and Advanced options. 

 

Notice: The Project Properties setting interface can also be opened directly 

via the navigation bar. The navigation bar contains the general process of 

HGO data post-processing. 
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Figure 1-2-3 Navigation Bar 

3. Coordinate system setting 

 

Figure 1-2-4 Coordinate Parameter Interface 
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Select File → Coordinate System, or open the Coordinate Parameter interface directly through 

the navigation bar to set the local reference ellipsoid, projection and other parameters. 

4. File import 

 

Figure 1-2-5 Import Interface 

Select File → Import to choose the type of data to be loaded, click Select Files or Select Folder 

to choose the corresponding data. 

Users can also import files through the navigation bar. 

 

Figure 1-2-6 Import Navigation Bar 
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After importing the data, the software will automatically form baselines, synchronization loop, 

asynchronous loop, and repeated baselines. 

 

Figure 1-2-7 Import Data 

5. File information editing 

 

Figure 1-2-8 File Information 
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After the data is loaded, the system will display all the files, click Observation Files in the tree 

directory in the middle, and switch the right workspace tab to Obs-Files, to view the detailed file 

list. Double-click on a row to pop up the editing interface, to enter or edit the antenna height, 

receiver type and antenna type. Users can also directly modify the point name, antenna type and 

antenna height information in the file list. 

6. Baseline processing 

After the data is loaded, the system will display all the GPS baseline vectors, and the Project 

Plot interface will display the entire GPS network. Click Process Baseline → Process All in the 

menu, the system will use the default baseline processing settings to process all baseline vectors. 

 

Figure 1-2-9 Baseline Processing 

The progress of the entire baseline process is displayed during processing. The processing of 
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each baseline can also be seen from the Baselines list. 

The time of the baseline processing is affected by the number of baselines, the time of baseline 

observations, the baseline processing settings and the computer speed. After processing all the 

baseline vectors, all the solutions are listed in the baseline list. Original unsolved baselines in the 

network are also changed from a light color to a deep color. 

7. Settings before adjustment 

After the baseline processing is complete, the result needs to be checked. Since this chapter is a 

quick start, it’s assumed that all baselines involved in the solution are qualified. Normally, if 

observation conditions are good, all baselines can be successfully processed at once. After the 

baseline solution is qualified, some baselines need to be removed, according to synchronized 

observation conditions, which won’t be described here. 

 

Figure 1-2-10 Set as Control Point 
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Now go directly to the preparation of the network adjustment. Firstly, users need to confirm 

which sites are control points. 

Select Points in the tree directory and click the Points tab in the right workspace. Select Set as 

Control Point in the right-click menu of the selected site, and these points will be automatically 

added to the Control Points list. 

Switch to the Control Points list and double-click to edit it. 

 

Figure 1-2-11 Control Point Details 

Use the same method to enter all the known point coordinates. 

Then select Network Adjustment → Adjust Options in the control menu to enter the Adjust 

Options interface to do settings. 
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Figure 1-2-12 Adjust Options 

8. Network adjustment 

Select Network Adjustment → Adjust in the control menu, it will pop up the adjustment tool. 

 

Figure 1-2-13 Adjustment Tool 
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Click Auto Adjust, the software will automatically complete the Free, 3D Biased in WGS84 

Datum and 2D Biased and Height Fitting adjustment, according to the starting condition and 

form a list of adjustment results. Users can select the results they want to view, and click Get 

Report to view the report. 

9. Report output 

Select Network Adjustment → Report Options to specify and select the output content and format. 

 

Figure 1-2-14 Adjust Report Options 

Then click Get Report in the Network Adjustment → Adjust to export the corresponding 

adjustment report. 
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Taking the HTML file report as an example, the entire content in the adjustment result is output 

as the HTML file form. 

 

Figure 1-2-15 Adjust Report 

Until now, the complete baseline solution result and coordinate results of each site have been 

obtained, and the static GPS data processing is complete. 

1.2.2 Dynamic GPS Data Processing 

The dynamic GPS data contains two files, including the base station data file and the rover station 

data file. 

After importing files, according to the method described above, set the rover station file to the 

dynamic type in the right-click menu, and then choose Process Baseline: the software will 

process the data according to the dynamic route mode. 
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Figure 1-2-16 Switch to Static/Kinematic 

Switch to the Baselines list, the type of the baseline formed by the two files will be Dynamic. 

 

Figure 1-2-17 Baseline List 
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Select the dynamic baseline in the baseline list, right click and select Process to complete the 

baseline processing. After processing, users can right click and select Report to view the report, 

which forms the positioning result of each epoch. 

 

Figure 1-2-18 PPK Report 
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2.1 Main Interface 

Run HGO.exe to enter the main program of the HGO software.  

The software interface consists of Menu Bar, Tool Bar, Status Bar, Navigation Bar, Message Area, 

and Workspace. 

 

Figure 2-1-1 Main Interface 

Select the File menu to open a project: the interface is divided into several areas. 

1. Title Bar 

The initial purpose of the title bar is to help you quickly determine the current application class. 

However, you can control for some basic programs, such as maximizing, minimizing, and exiting 

the software. If the project is currently open, the project path is displayed. 
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2. Menu Bar 

The drop-down menu is an important part of any Windows application window. It provides the 

majority of commands for building projects, solving data and managing data.  

3. Tool Bar 

Provides most of the commonly-used shortcut commands to speed up various operations. 

4. Status Bar 

Shows tips for the current operation. The status bar can also be hidden. 

5. Workspace 

The user area is the main area for users to work, usually including views related to the project. 

6. Navigation Bar 

Stores the common shortcut commands. 

7. Message Field 

Outputs intermediate process information when processing data. 
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Figure 2-1-2 Several Areas of Interface 

 

Figure 2-1-3 Working Interface 

Menu Bar  Title Bar 

Tool Bar 

Workspace 

Message Area 

Status Area 

Navigation Area 
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Next, we will introduce specific operations of the main program. 

 

2.2 Menu & Toolbars 

2.2.1 Menu 

The main menu of the program consists of File, Baseline Processing, Network Adjustment, Tools, 

Settings and Help. Each menu item has a corresponding Windows shortcut. Most of the data 

processing work can be done through the operations provided by the menu items. The menu 

covers the main process steps. 

 

Figure 2-2-1 Menu 

2.2.2 Toolbars 

Through the toolbar of the main program, you can directly execute common functions, which 

can speed up the software. 

The toolbar includes Open Project, New Project, Import Data, Save Project, Export Data, and 

Restore Default View. 

 

Figure 2-2-2 Tool Bar 
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2.2.3 Navigation Area 

The navigation area is a shortcut entry to the menu bar, which can be displayed and hidden 

according to user habits. It is used to save user interface or speed up operations. 

 

Figure 2-2-3 Navigation Area 
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2.3 Plan View 

The contents of the plan window mainly display auxiliary information such as the station, 

baseline information and scale, and grid reference line of the project. 

 

Figure 2-3-1 Data Plot 

1. Station 

If the GPS observation station has been associated with the control point, it is indicated by ▲, 

and the point not associated with any control point is indicated by ●. 

2. Baseline 

Static baselines are represented by lines with arrows. When the baseline is not solved, or does 

not participate in the solution, the baseline is grey, and navy blue after solution. 

Move the mouse, when the mouse clicks on the static baseline, above the observation site, the 
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static baseline and the observation site will be highlighted. At the same time, the middle tree 

menu will be positioned to the baseline. 

3. Error ellipse 

After the baseline solution is completed, the error ellipse of the baseline and the residual in the 

direction of elevation are displayed in cyan to visually determine the quality of the solution for 

the baseline. 

2.3.1 Graphic Operation Buttons 

There is a row of graphic operation buttons in the upper right corner, you can click the button 

and then click on the plot to achieve the corresponding graphic operation. 

 

Figure 2-3-2 Graphic Operation Buttons 

  Select the site and baseline of the 

network graph. 

  Square select zoom 

  Zoom out 

  Zoom in 

  Full screen 

  Pan move 

  Grid reference line displayed  

  Error ellipse displayed 

  Rover point displayed 

2.3.2 Right-click Menu Operation 

Right-click in the plan display area, to pop up the right-click menu, and click the relevant function 
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to realize the corresponding graphic operation. The menu function corresponds to the graphic 

operation button. 

 

Figure 2-3-3 Right-click Menu 

- Select: Select a baseline or a station; 

- Zone Frame Selection: Drag the mouse to select the area to be enlarged; 

- Zoom Out/Zoom In: Click the mouse to zoom out/in the plan; 

- Full Screen: Display plan in Full screen; 

- Pan: Drag the mouse to move the graph; 

- Grid Line Switch: Turn grid coordinates on/off; 

- Error Ellipse switch: Turn error ellipse on/off; 

- Save Graphics: The screenshot saves the current figure. 
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2.3.3 Changing the Drawing Mode  

Choose Options→ Customize menu item, enter the custom configuration dialog, and you can 

set the drawing mode of the plan grid reference line as a plan or geodetic coordinate, by setting 

the second item. The software supports Meter, Feet or User Define Length unit settings. 

 

Figure 2-3-4 Customize Menu 
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2.4 Tree List View 

The left of the work field is a tree list view. It is used to manage all contexts of the project, 

including points list, baselines list, synchronous loop list, asynchronous loop list, observation 

files list, ephemeris files list. Click on one node in the list, the detail view, which is in the work 

field, will display related information, according to the selected node. Click on an observation 

file in the tree list, the five tabs related to the file information will appear in the detailed view of 

the workspace, namely Project Plot, Obs-Files, SSP and QC, Data, Sky Plot, and show the data 

plot of the file. 

 

Figure 2-4-1 Tree List View 

The first letter of the name represents a different constellation type. 

G: GPS 

R: GLONASS 

C: BDS 

E: GALILEO 
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Figure 2-4-2 Data Plot 

 

2.5 Detail View 

The detail view of work field contains several tabs, every tab will display or hide to get different 

display combinations, according to the selected node of tree list. 

 

Notice: The tabs of detail view will change automatically according to the 

selected node of tree list, users don’t need to search. 

 

2.5.1 Pop-up Menu of Detail View 

Choose one item in the detail view and right click on it, the pop-up menu will display. 
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Figure 2-5-1 Pop-up Menu of Obs-Files 

- Edit: Open Edit to modify the basic information, antenna information, and receiver information 

of the selected file. 

- Open: Open the selected original file 

- Delete: Delete selected file 

- Convert to Rinex (R): Convert selected files to Rinex format  

- Rinex Options (S): Set options of Rinex output, including version, output system, output content, 

output sample interval, and type of antenna height  

- Open Rinex Folder (F): Open the folder of the converted and stored Rinex files 

- Switch to Static/Kinematic (C): Convert the type of the selected file to static/kinematic 

- SPP and QC Result (P): Click to the Single Point Position and QC tab to view the single point 

position and QC results of the selected file. 

-Single Point Position (F): Re-single point positioning for selected files 
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- Quality Check (B): Re-check the quality of selected file 

- Data Track (T): Click and switch to the Data Plot tab to view the plot of the selected file. 

- Skyplot (Q): Click to the Skyplot tab to view the satellite trajectory of the selected file. 

-Update Skyplot (G): Regenerate the satellite trajectory of the selected file   

-Add Stop&Go RSP File (B): Select and add the Stop&GO RSP file in the pop-up dialog box. 

-View Stop&Go Info (L): Open the Stop&GO information file 

- Delete Stop&Go Info (W): Delete Stop&GO information for the selected file 

2.5.2 Property Window 

You can open the property window by clicking Modify Properties in the pop-up menu, or by 

double-clicking an item in the list. 

 

Figure 2-5-2 Property Window
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HGO data processing software is project-oriented. Hence, whether you carry out single point 

positioning, static baseline processing, dynamic route processing, or network adjustment, first 

create a new project, or open an established project. 

The following steps create a new project: 

1. Establish a new project, determine the project name and the save path; 

2. Set the project properties and determine the quality inspection standard; 

3. Input coordinate parameters in the coordinate system management; 

Then proceed to the next step. 

 

3.1 Create a New Project  

3.1.1 Set the Project Properties  

Click File  Project Properties, set the project properties.  

1. Basic Information  

The basic information is displayed in the network adjustment report. 
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Figure 3-1-1 Project Properties 

2. Tolerance 

Setting tolerance is very important, you can use national standard or user-defined. Many tests 

are conducted according to the setting of tolerance during data processing. For the national 

standard of tolerance, please refer to its corresponding country. In this Software (HGO) you can 

adopt different standards. 
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Figure 3-1-2 Project Properties 

3. Advanced 

Advanced settings decide the project control settings when processing data, such as using several 

characters in the front of *ZHD as the point name, minimum observation time of static baseline, 

minimum observation time of dynamic baseline, maximum length of baseline, forming repetitive 

baseline and time of closed loop, etc. 
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Figure 3-1-3 Project Properties 

3.1.2 Coordinate Parameters Settings 

Click the File menu→Coordinate System item to begin the setting. 

 

Figure 3-1-4 Settings 
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When a project is working, it generates some necessary files, which are saved in the project path 

and its s sub-catalogs. When we check these working catalogs, as shown in the figure, we can 

see the project file named *.HGO, a coordinate transformation file named .dam and 7 sub-

catalogs under the working catalog. The Adjust file stores the Network Adjustment information, 

the Baseline file stores the intermediate information of the baseline processing, the Copy file 

backs up the last saved project, the EphBinData file stores the ephemeris data, the ObsBinData 

file stores the observation data, the Report catalog stores file report, and the Rinex file stores the 

Rinex files transformed from observation files. 

 

Figure 3-1-5 Report Catalog 

In this way, all the data and intermediate processing result have been stored in the corresponding 

catalog. When one project is finished, the entire catalog and its sub-catalogs can be packed up 

and saved. In addition, the project file can be moved from one computer to another and run with 

no problem. 
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3.2 Observation Data  

The data format of the GPS receiver is classified into two types: NMEA 0183 and original 

observation data. 

HGO data processing software uses the original observation data of the GPS receiver. The raw 

observations of most GPS receiver outputs are binary data in different formats. 

HGO can process user-defined GNS/ZND format and standard RINEX text formatting. 

3.2.1 Contents of Observation Data  

The ObsBinData file mainly stores the original observation data of each epoch recorded by the 

GPS receiver. Each epoch includes the observation time, the satellite tracking information, C/A 

code pseudo range, P1 code pseudo range, P2 code pseudo range, L1 carrier phase and L2 carrier 

phase of each channel. For static observation files of HGO, the observation file is required to 

include at least the observation time, C/A code pseudo range, and L1 carrier phase, and for 

dynamic observation files, at least the observation time and C/A code pseudo range. 

In addition to the above information, the observation file also includes position information, 

initial coordinate, and ephemeris information related to the observation file. 

Observation files can be shown as the following Figure 3-2-1: 
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Observation File 

Position Information 

Initial Coordinate 

Ephemeris Data or Ephermeris File 

Epoch1 

Epoch2 

Time and Data in all channel 

Time and Data in all channel 

 

... ... ... ... ...  

Information Received in Observation  

... ... ... ... ...  

  

Figure 3-2-1 Contents of Observation data  

3.2.2 Formats of Observation Data 

1. Hi-Target ZHD/GNS Format 

ZHD/GNS observed files are all included original observation data, ephemeris data, original 

coordinate of observation stations and so on. Some individual versions also include point 
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coordinates and road information collected by dynamic acquisition. 

2. RINEX Format 

The RINEX format is a general data exchanged format to process data from different types of 

receivers. The RINEX format was proposed by the Institute of Astronomy of Bern University, 

Switzerland. Nowadays this format is widely used in schools, research institutions as standard 

input format, while preparing software. Moreover, GPS receivers at home and abroad can 

transfer observation data to RINEXT data. 

At present, in order to adapt the demand of multi-system and multi-observed channels, the Rinex 

format has upgraded its vision to 3.x. For more details of RIENX 2.x, please consult relative 

contents and appendix C. For the Specification of 3.x format, please consult the official 

documentation. 

3. Other Formats 

HGO also supports other formats’ observation data, such as the precision ephemeris file. 

3.2.3 Data Preparation  

HGO data processing software can process a variety of data formats. Generally, before the GPS 

data processing, it needs to follow the steps as below. 

1. Data import  

Click File menu→Import or click in the navigation field. 
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Figure 3-2-2 Data Import 

On the right of the dialog box, there is a type of combo box for observing files, in this box the 

default content are automated and there are two options for static observing files and dynamic 

observing files. 

The Import catalog will automatically traverse all the eligible files that meet the conditions. It is 

appropriate for multi data processing in large-scale projects, according to folder organization. 

Now, if you choose the Rinex file, it will come out a file dialog box, as the picture shows below. 

The file dialog box will transfer automatically to the current file path and list the relative 

extension files under it. Users can choose one file or multiple files at a time. 

 

Figure 3-2-3 File Dialog Box 
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While importing the observation file, the software will search automatically and import 

corresponding ephemeris files. As for ZHD/GNS format’s files, if observation files and 

ephemeris files are combined in the same document, they will be imported at the same time. 

However, for other formats, where observation files and ephemeris files are not in the same file, 

in this case, they should be placed in the same file, and the software will automatically distinguish 

and import the ephemeris files according to the format of observation files. Otherwise, users 

should input the ephemeris file in subsequent processing. 

After finishing the importation, the software will extract observation points from the files and 

combine them automatically into static baselines and dynamic baselines based on their 

observation periods. 

 

Figure 3-2-4 Observation Files  
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2. Observation File Name  

Usually, the observation files will be identified by different file names. The usual name of the 

observation file consists of 8 file names and the extension. For example, the file name of an HGO 

GNS observation file is ABCD1234.GNS. 

In a project, no duplicate file names are permitted. For example, ABCD1234.GNS and 

ABCD1234.01O can’t exist at the same time. 

An observation file name is usually formed by the station name and period, in this way, under 

the same project, it can make sure that all the file names are different. 

- ZHD/GSN Observation File 

For ZHD/GNS static observation files, the file name is formed by 8 characters: 

 

Figure 3-2-5 Observation File Name 

The Point Name: In the observation file’s name, the 4 !!!! significant point’s name, it can be 

formed by characters and numbers. After loading the observation file, the software will 

automatically decompose the point name according to the file name. If the name is less than four 

characters, the data transmission software of the acquisition software or HD8200 will 

automatically make up 4 characters by adding underscore '_' before the point name. For example, 

the point name A will become "___A". 

Period: The last three numbers and an English character, or numbers $$$# indicate the time 
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period. Among them, the $$$ represents the day of year, that is, the order of the observation day 

in a year. For the day of year, see Appendix B. The # indicate the observation sequence of a day, 

which can be denoted by 1, 2, 3, … A, B, C,…, Z.  

For the HGO GNS dynamic observation files, it’s also denominated in the same way, but the 

name of the observation site doesn’t have any meaning, it is only used for identifying different 

files. 

- HDH observation files 

HDH observation file has the same name as observation line file of marine survey software. 

- RINEX observation files 

The name in RINEX format is as follows: 

Observations file: !!!!$$$#. yyO  

Ephemeris file: !!!!$$$#. yyN 

It is obvious that the naming rules of the RINEX file are similar to the ZHD/GNS file, except 

that yy indicates the year of observation. In the RINEX format, the name of the observation 

station is recorded in the part of the MARKER NAME. If this part is empty, the software will 

analyze the name of the observation file by reading the name of the station in the ZHD file to 

form a station and other information. 

If some file names in RINEX format don’t follow this rule, please rename those files before 

importing them to the HGO processing data software.  
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- Other Observation Files 

Please consult other relative resources for other observation files. 

3. Pop-up Menu of the Observation File 

In the workspace detail view, choose one observation file in the list view of the Observation 

Files, then right-click this option to do the relative operation for the observation file. 

 

Figure 3-2-6 Pop Menu of Observation File  

4. Observation File Attributes 

In the workspace detail view, choose one observation file in the list view of the Observation 

Files, then right-click to select Edit. A label dialog box about the observation file will pop up. 



HGO User Manual  

45 

 

Figure 3-2-7 Edit Menu 

The label dialog box is divided into three parts: Basic, Antenna, and Receiver.  

5. Single Point Position Result of Observation Files 

In the workspace detail view, choose one observation file in the list view of the Observation 

Files, then right-click to select Single Point Position. The SPP and QC tab will be activated, 

and the single point position result of this file will be shown. 

 

Figure 3-2-8 Single Point Position 
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6. Data Quality Inspection of Observation Files 

HGO has a function of data quality inspection, choose one observation file in the list view of the 

Observation Files, then right-click to select Quality Check, the software will analyze data 

automatically. While clicking HTML, it will show the result of the data quality inspection. 

Figure 3-2-9 Quality Check  

 

Figure 3-2-10 Quality Report 

7. Observation sequence of observation files  

In the workspace detail view, choose one observation file in the list view of the Observation 

Files, then right-click to select Data Track. It will show the tracking situation of satellite data, 

wherein the interruption indicates different situations, like the receiver lock-lose.  
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Figure 3-2-11 Data track 

8. Sky plot and SNR Plot 

In the workspace detail view, choose one observation file in the list view of the Observation 

Files, then right-click to select Skyplot, it will display the trajectory of the satellite in the file and 

the signal-noise ratio of the L2 band. 

 

Figure 3-2-12 Sky plot 
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3.3 Observation Station 

Click on Point in the tree view, the detailed display of the right work-space will show the tabs 

related to the observation site. There are two tabs, Points and Control points. The control point 

list is used for adjustment module, it is not related to baseline solution. 

 

Figure 3-3-1 Control Points 

The list window lists the name of each observation station, whether it is fixed (associated with 

the control point), space coordinates or target coordinate. 

3.3.1 Observation Station Pop-up Menu 

Choose one observation station of the Points option in the workspace detail view, right –click to 

get the pop-up menu as shown below for site-related operations. 

 

Figure 3-3-2 Pop Menu of Points 
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3.3.2 Property of Observation Site 

Choose one point, double click or right-click to choose Edit, we can obtain the point name and 

information of coordinates through the property box. 

 

Picture 3-3-3 Station 

The software records the coordinate information of all sources from the station. By changing 

the Coordinate Source, the coordinate values of different sources can be displayed. The 

coordinate information of the source can be assigned to the coordinate information used by the 

current station, by clicking the Save button, or manually edited. 
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Figure 3-3-4 Station 

 

3.4 Static Baseline 

Click on the Baseline node in the tree view, and the detailed view of the right work space will 

display the tabs associated with the baseline. 

 

Figure 3-4-1 Baselines 
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The Baseline window lists the name of the baseline, the observation data used in the baseline 

solution, the solution used for the baseline, and the solution situation. 

Choose one baseline of the Baselines option in the detailed view of working area, right-click 

and baseline related operations are available. 

 

Figure3-4-2 Baseline Settings 

3.5 Repeated Baseline 

Click on the Repeated Baseline node in the tree view, and the detailed view of the right 

workspace will show tabs associated with the repeated baseline. 
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Figure 3-5-1 Repeated Baseline  

 

3.6 Closed Loop 

Click on the Sync loop or Async loop in the tree view, and the detailed view of the right workspace 

will show the tabs associated with the closed loop. 



HGO User Manual  

53 

 

Figure3-6-1 Closed Loop 

 

3.7 Hi-Survey Project 

Hi-Survey projects can be imported into HGO software. 

 

Figure 3-7-1 Import 

While choosing the corresponding Hi-Survey project, HGO will load the project and display it. 
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Figure 3-7-2 RTK Field Data 

Users can click the CSV or HTML to let HGO to export the details of Hi-Survey projects.
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Static Baseline Processing 

 

This chapter contains:  

 

 Baseline Processing Settings 

 Baseline Processing 

 Baseline Processing Result Test 

 Discrimination of Various Influential Factors 

 Repeat Processing a Baseline 
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4.1 Baseline Processing Settings 

Before the baseline vector processing, users need to do the baseline vector processing settings, 

and execute Processing Options under the menu Baseline, then the dialog box will appear. 

 

Figure 4-1-1 Processing Options 

The dialog box consists of four pages, namely, general settings, tropospheric and ionospheric 

settings, dynamic solve mode and advanced settings. 

The meaning of each item in the dialog box is briefly introduced below. 

4.1.1 General Settings 

1. Elevation mask 

The elevation mask angle is used to restrict satellite data at a lower altitude, so that it does not 
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participate in the baseline solution. 

Because of the complicated influence of the atmosphere on the satellite signals with relatively 

low altitude, it is difficult to correct these signals with the model. In addition, these kinds of 

signals are easily affected by various factors such as multipath and electromagnetic waves, for 

that the signal quality is usually low. Therefore, in data processing, they are usually removed. 

For example, from the perspective of the atmosphere refraction, the elevation angle can be 

reduced for short distance observation, and it should be increased for long distance observation, 

because the shorter the distance, the easier the atmospheric refraction is to be cancelled out. Of 

course, the setting of the elevation angle also depends on the surrounding environment of the 

observation station. 

When observing in the field, the elevation angle should be reduced according to the satellite 

distribution, in order to collect as much data as possible for easy processing. 

 

Figure 4-1-2 Elevation Mask 

The default elevation angle is 20 degrees in HGO. 
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2. Sampling interval 

The so-called epoch interval is the interval at which the software extracts data from the raw 

observation, during baseline processing. 

For example, two instruments are set to collect a set of data every 5 seconds, during static 

observation, but when it comes to indoor processing, the high density of the observation data 

cannot significantly improve the baseline accuracy; on the contrary, it will greatly increase the 

time of the baseline processing. Therefore, to improve the speed of baseline processing, users 

can appropriately increase the sampling interval of data processing. 

So, what is the appropriate sampling interval? It is generally considered that, for the short 

baseline, when the observation time is short, the sampling interval can be appropriately reduced, 

while for the long baseline, the sampling interval can be appropriately increased. For example, 

for a static baseline within 2 km and an observation time within 20 minutes, we can set a 

sampling interval of 5 seconds. However, when the baseline is long, the sampling interval can 

usually be increased to 60 seconds or 120 seconds. 

So, why do we need to set a smaller sampling interval in the field observation? This is because, 

when the data is not very good, due to the certain randomness of the observation data and the 

limits of the software itself, the processing results can be improved by reprocessing the baseline 

after the modification of the epoch interval. 

The default epoch interval of the software varies with the observation time, 5s in 10 minutes, 30s 
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in 10 minutes to 2 hours, 60 seconds in 2 hours to 6 hours, and 120s in more than 6 hours. 

3. Minimum epoch 

Since the receiver must observe continuous carrier phase during the observation process, if there 

is a continuous cycle slip over a period of data, the quality of the data is usually very poor, which 

often affects the quality of baseline processing, so it should usually be eliminated. Therefore, 

during baseline processing, the software will eliminate data segments that do not exceed the 

minimum epoch. 

4. Observations (frequency) 

Different combinations of observations can be used for baseline solutions, such as wide lane 

combination Lw, narrow lane combination Ln, etc. When the automatic mode is adopted, the 

software will automatically select the type of observation, according to the length of the baseline. 

Generally, a baseline less than 10km is solved by the L1 observation, and a baseline longer than 

10km is solved by the observation of the Lc ionosphere-free combination. 

5. Ephemeris (navigation) 

The broadcast ephemeris, or the precise ephemeris, can be used for the baseline solution. For the 

long distance baseline, the precision of the baseline solution can be improved by using the precise 

ephemeris, and for the short baseline, the broadcast ephemeris meets the requirements. 

6. Reference satellite 

Since the double-difference observations are formed by the difference of the single-difference 
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observations between the satellites, the software adopts the method of selecting the reference 

satellites in order to facilitate the processing of the double-difference observations. 

The default setting is automatic. At this time, the software will select satellites with the most 

observation data and higher altitude angle as reference satellites. However, due to the influence 

of observation conditions, such selection may not be the most reasonable. When the reference 

satellite is not properly selected, it will affect the baseline processing results. At this moment, 

the user is required to reset the reference satellites, according to the observation data. 

7. Auto process mode 

HGO's baseline solution engine has the function of automatically eliminating the gross error in 

satellite data, which can help users reduce the manual data culling and make the baseline solution 

qualified in the shortest time. The function can be enabled when the item is set to Advanced and 

if the users want to manually erase data and do not want the software to automatically delete the 

problem data, set this item to Normal. 

8. System 

HGO software supports an arbitrary combination solution of GPS, GLONASS, COMPASS and 

GALILEO systems. 

9. Processing time 

The software handles all the public data of the base station and the rover by default. If you need 

to process the data for a fixed period of time, you can manually set the start and stop time. 
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4.1.2 Ionosphere / Troposphere 

In general, there is no need to change troposphere and ionosphere settings. The medium and long 

baselines can be set according to the actual situation to improve the solution accuracy. 

 

Figure 4-1-3 Ion/trop 

4.1.3 Advanced 

The figure below shows the advanced settings dialog. Under normal circumstances, the default 

value can be used to meet the requirements. It is not recommended for users to make illegal 

changes, which affects the stability of the solution engine. 
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- Gross error detect: The coefficients of the gross error data that are automatically eliminated 

according to the double difference residual size, when the baseline is solved, that is, when the 

double difference residual generated by an observation data is larger than the gross error 

coefficient *RMS, the observation data is eliminated. 

- Triple Diff. Max.: the tolerance threshold of the cycle slips repairing, but the cycle slips value 

is repaired when the difference between this value and the integer, obtained by rounding, is less 

than the threshold, otherwise it is regarded as gross error. 

- Minimum Ratio: The threshold of the fixed ambiguity with the Lambda algorithm. 

- Chi Probability: Confidence in the  2 test of RMS. 

- Pseudo range precision: Pseudo range observation error. 

- Phase observation precision: Phase observation error. 

- Split Sessions, if start time differs: When the baseline observation time exceeds the value, it 

will be solved in two periods. 

- Use L1, if baseline shorter than: when using the automatic model for baseline solution, L1 

model is adopted when the baseline is less than this value, when it is longer than this value, the 

Lc modulo is used to solve the problem. 

- No L1 Fix: When the single-frequency baseline length is larger than this value, the ambiguity 

is not fixed, and the floating solution is directly output. 
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Figure 4-1-4 Advanced 

4.1.4 Baseline Processing Menu 

Click Baseline to bring up the baseline processing menu. 

 

Figure 4-1-5 Baseline 
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Among them: 

- Search All Repeated Baseline and Loops: search all the repeated baseline and loops in the 

baseline network. 

- Search Selected Repeated Baselines and Loops: Search for the closed loops and repeated 

baseline that meet the criteria, based on the set maximum number and the minimum number of 

edges of closed loops. The search results are displayed in the tree view on the left. 

 

Figure 4-1-6 Loop Line Num 

 

4.1.5 Baseline Processing 

After the above preparations, execute Process All under the Process Baseline menu, and the 

program will start processing all the baselines, one by one, and the information dialog will appear. 

In the dialog, the name of each solution baseline, the progress of the baseline solution, and the 

information for each baseline solution are listed. 
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Baseline solution runs in the background in multi-threading mode. In the process of operation, 

we can choose to cancel the baseline solution. 

 

Figure 4-1-7 Processing 

After the baseline solution, the result will be obtained in the calculation window. 

 

Figure 4-1-8 Result 

The status bar will have a warning message, click on the warning message to display the 

corresponding baseline in the list. 
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The results of the baseline solution can also be generated by clicking Report in Process Baseline. 

 

Figure 4-1-9 Baseline Process Report 

 

4.2 Baseline Processing Result Test 

4.2.1 Control Baseline Quality 

After the baseline solution, the quality of the baseline solution can be measured by the quality 

indicators of RATIO, RMS, and positional accuracy. 

1. RATIO 

RATIO is the ratio of the sub-minimum RMS to the minimum RMS after the integer ambiguity 

resolution. That is: 

min

sec

RMS

RMS
RATIO 

 

RATIO reflects the reliability of the ambiguity parameters, which depends on a variety of factors. 

It’s related to the quality of the observations and the observation conditions. 

RATIO is the most critical value to reflect the quality of the baseline. Under normal 
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circumstances, the RATIO value is greater than 1.8. 

2. RMS 

RMS is the Root Mean Square, that is: 

fn

PVV
RMS

T




 

Where:  

V is the observation residual; 

P is the weight estimation of the observations; n-f is the total number of observations, minus the 

unknown number. 

RMS indicates the quality of the observations. The smaller the RMS, the better the quality of the 

observations. It is not affected by the observation conditions (such as satellite distribution). 

According to the theory of mathematical statistics, the probability of the observation error falling 

within the range of 1.96 times RMS is 95%. 

3. Point Accuracy  

Point accuracy is an important indicator of accuracy in response calculation results. It is the result 

of the joint strength of GDOP and RMS. It can be divided into the horizontal direction accuracy, 

the vertical direction accuracy, and the baseline length accuracy, etc. The software will check 

the different precision indexes according to the setting of the limits of the project attributes. 
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4.2.2 Closed Loop Testing 

1. Error of Closure 

Closed loop test is a powerful way to detect baseline quality. 

The closed loop can be divided into synchronous loop, asynchronous loop and repeated baseline. 

The error of closure of the closed loop should theoretically be 0. In the actual measurement, it is 

allowed to deviate from a certain value. Please refer to the relevant documents about the closure 

difference of the closed loop. 

The closure difference of the closed loop can be divided into: 

- Component misclosure, that is: 


















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
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
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- Total misclosure, that is: 


 


S

ZYX

222




 

Where, S
means ring length. 

2. Synchronous loop, asynchronous loop and repeated baseline 

- Synchronous Closed Loop 

The closure error of the synchronous loop is the closure difference of the closed loop composed 
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of synchronous observation baselines. 

Due to the inherent relationship between the synchronous observation baselines, the closure error 

of the synchronous loop should always be 0. If the closure error of the synchronous loop is out 

of limit, it is wrong to have at least one baseline vector in the baseline of the synchronous loop. 

However, on the contrary, if the closure error of the synchronous loop is not exceeding the limit, 

only the static baseline is considered to be qualified, in most cases, it cannot be said that all the 

baselines that make up the synchronous loop are absolutely qualified in quality. 

- Asynchronous Closed Loop 

A closed loop, that is not completely composed of a synchronized observation baseline, is called 

an asynchronous loop, its closure error is called the closure error of the asynchronous loop. 

When the closure error of the asynchronous loop satisfies the requirement of the limit difference, 

it indicates that the quality of the baseline vector making up the asynchronous loop is qualified. 

When it does not meet the requirement, it indicates that at least one baseline vector of the 

asynchronous loop is unqualified. Unqualified baselines can be carried out by multiple adjacent 

asynchronous loops or repeated baselines. 

- Repeated Baseline 

The observed results of different observation periods for the same two stations are called repeated 

baselines. The difference between these observations is the repeated baseline difference. 
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Notice: Each time the search is closed, there is information about the closed 

loop at the bottom of the calculation area. Double click on a message to find 

the corresponding baseline in the list. 

4.2.3 Free Network Adjustment Test 

For the free network adjustment test, please refer to the chapter "Network Adjustment". 

 

4.3 Various Influence Factors 

4.3.1 Influence Factors 

There are several main factors affecting the results of the baseline solution: 

1. The coordinates of the starting point is set inaccurately during the baseline solution. Inaccurate 

coordinates can cause deviations in the scale and direction of the baseline. 

2. The observation time of the satellite is too short, so that the ambiguity parameters of these 

satellites cannot be accurately determined. For the baseline solution, the entire baseline 

processing result will be affected if the ambiguity parameters of the satellites participating in the 

calculation are not accurately determined. 

3. There are too many cycle slips during the entire observation period, which make the cycle 

slips repairing imperfect. 
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4. The multipath effect is more serious during the observation period, and the correction value 

of the observation is generally larger. 

5. The tropospheric and ionospheric refraction is too strong.  

6. The electromagnetic wave is affected too much. 

7. There is a problem with the receiver itself, resulting in poor data quality. For example, the 

accuracy of the phase measurement of the receiver is reduced, the clock is inaccurate, etc. 

4.3.2 Discriminate Influence Factors 

1. Discrimination of factors affecting GPS baseline solution results  

- Introduction 

Some factors that affect the GPS baseline solution result are easier to distinguish, such as - the 

satellite observation time is too short, the cycle slips are too great, the multipath effect is serious, 

the tropospheric or ionospheric refraction is too large, but for other factors it is difficult to 

discriminate, such as - the starting point coordinates are not accurate. 

- Discrimination of baseline starting point coordinates 

There is currently no way to discriminate the impact of inaccurate starting point coordinates on 

baseline solution quality. Therefore, in actual work, only the accuracy of the starting point 

coordinates should be increased as much as possible to avoid this effect. 

- Discrimination of satellite observation time 
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The judgment on the problem that the satellite observation time is too short is relatively simple, 

as long as the number of observation data for each satellite in the recording document is viewed. 

The HGO GPS post-processing software also outputs the satellite visibility map, which is more 

intuitive. 

- Discrimination of too many cycle slips 

For the case of too many cycle slips in satellite observations, it can be analyzed from the 

observation residuals obtained after the baseline solution. At present, most of the baseline 

processing software generally uses double-difference observations. When an observation of a 

satellite in a station contains unrepaired cycle slips, all the residuals of the double-difference 

observations associated with it are present. There will be a significant integer multiplication. 

- Discrimination of severe multipath effects and excessive tropospheric or ionospheric refraction 

We also discriminate the multipath effects, tropospheric or ionospheric refraction by the 

observation residuals. However, unlike the cycle slips, when the multipath effect is severe and 

the tropospheric or ionospheric refraction is too large, the observation residuals has no integer 

multiple increase but only a non-integer multiple increase. It usually does not exceed 1 cycle, 

but is significantly larger than the residual of normal observations. 

2. Solutions 

- The solution to inaccurate baseline starting point coordinates 

To solve the problem of inaccurate coordinates of the baseline starting point, we can use the point 
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with higher coordinate accuracy as the starting point of the baseline solution. The more accurate 

starting point coordinates can be obtained by long-term single-point positioning, or by point-

accurate measurement with WGS-84 coordinates. It is also possible to use the method that the 

coordinates of all baseline starting points are derived from a point coordinate, so that the baseline 

results have a certain system deviation, and then the system parameters are introduced in the 

GPS network adjustment processing to solve it. 

- The solution to short satellite observation time 

If the observation time of a satellite is too short, the observation data of the satellite can be 

deleted，for that they are not allowed to participate in the baseline solution, thus ensuring the 

quality of the baseline solution result. 

- The solution to too many cycle slips 

If multiple satellites frequently have cycle slips during the same period of time, the method of 

deleting the severe period of the cycle slip can be used to improve the quality of the baseline 

solution results. If only individual satellites have frequently cycle slips, the method of deleting 

the observations of satellites with frequent cycle slips can be used to try to improve the quality 

of the baseline solution results. 

- Multipath effects 

Since the multipath effect tends to cause large residuals of observations, it is possible to eliminate 

the observations with large residuals by narrowing the editing factor, or eliminating the time 
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period of large multipath effects or the satellites. 

- The solution to excessive tropospheric or ionospheric refraction  

Raise the elevation angle and eliminate the observation data of low elevation angle that is 

susceptible to the troposphere or ionosphere; this method is somewhat blind, because signals 

with low elevation angle are not necessarily affected by the troposphere or ionosphere. 

Use the model respectively to correct the tropospheric and ionospheric delays. 

If the observations are dual-frequency observations, the observations that eliminate the effects 

of ionospheric refraction can be used to do the baseline solution. 

3. Residual map - the powerful tool for baseline processing 

In the baseline solution, it is often necessary to determine the factors that affect the quality of the 

baseline solution, or to determine the unqualified observations of which satellite or which 

observation period. The residual map is very useful for accomplishing these tasks. It is a graph 

drawn from the residuals of the observations. Select the visible double difference residuals of 

the last and next satellites. 
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Figure 4-3-1 Data Plot 

The figure above is a form of a residual map of common double-difference observations, whose 

horizontal axis represents the observation time and the vertical axis represents the residual of the 

observations. 

 

4.4 Repeat Processing a Baseline 

Once the cause of the baseline quality is identified, a baseline can be processed repeatedly by 

modifying the baseline processing settings, or editing the baseline period. 

In the observation data graph, drag the mouse to select the data to be deleted. The data in the 

dotted line box will be blocked, not being processed by the software. Click Revoke in the previous 

step of recovery, and, to cancel all blocking, click Clear. 
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Figure 4-4-1 Data Plot 

In the baseline measurement, the baseline processing is sometimes unsatisfactory. In this case, it 

may be necessary to modify the baseline processing setting or editing period repeatedly, even in 

the case where the baseline cannot obtain a qualified solution. When this happens, we need to 

make this baseline not participate in the network adjustment, or delete it. If this baseline is 

essential in the baseline control network, then this baseline needs to be retested. 
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This chapter contains:  

 

 Baseline Processing Settings 

 Baseline Processing Menu  

 Baseline Processing 
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5.1 Baseline Processing Settings 

Before processing a baseline vector, the baseline vector processing settings are necessary. Click 

Baseline → process options → Dynamic, there will be a dialog box about Dynamic settings, 

including four options: Auto, RTD, Stop&Go, PPK. 

 

Figure 5-1-1 Dynamic Settings 

- Auto: According to whether there are RSP files to select its corresponding mode: Stop&Go or 

RTD. 

- RTD: Pseudo-range difference, lower precision. 
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- Stop&Go: High precision, apply to the RSP file which needs to synchronously load time with 

long distance, higher requirement for outdoor operations. 

- PPK: High precision, apply to media or short distance. 

5.1.1 Dynamic Baseline Solution Data 

Dynamic GPS data processing generally includes two types of data, base station static data and 

rover dynamic synchronous data. Before importing data, confirm which is static data and which 

is dynamic data, and import them as static data. 

HGO also supports PPK solution under the Hi-Survey Project. The data import process is: click 

Import → Hi-Survey Project, and import base station static data and rover dynamic synchronous 

data. 

 

Figure 5-1-2 Data import 
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While choosing the corresponding Hi-Survey project, HGO will load the project and display as 

Figure 5-1-3: 

 

Figure 5-1-3 RTK Field Data 

The users can click CSV or HTML to export the details of the Hi-Survey projects. 

5.1.2 Observation File and Site Properties Setting 

Select dynamic observation file and right click to choose static/kinematic for transferring to 

kinematic. 
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Figure 5-1-4 Observation File Settings 

 

5.2 Baseline Processing Menu 

Click Baseline in the menu bar and there will be a baseline processing menu. 

 
Figure 5-2-1 Baseline Processing Menu 
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Process Line: Process the dynamic baseline selected in the baseline list. 

Process Project: HGO V2.0.0 will automatically select the baseline solution engine, according 

to the type of baseline. 

 

Figure 5-2-2 Process Line 

 

5.3 Baseline Processing  

When everything has been prepared, run process project under the Baseline processing menu. 

The program will process all the baselines and there will be a dialog showing the names, 

processing rate, and processing information of each baseline solution. The baseline solution 

works in the background with the multi-threaded manner. During the process, you can click 

Cancel to stop the solution. 
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Figure 5-3-1 Processing 

There will be a result of baseline processing in the calculation window after finishing the baseline 

solution. 

5.3.1 Stop&Go Dynamic Baseline Processing 

1. Baseline processing settings 

In baseline list, select a dynamic baseline, and right-click Process Options for settings. 

 

Figure 5-3-2 Baseline Process   
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Notice: While using Stop&Go mode, the minimum number of epochs is 

recommended to default to 180. If the number of epochs is too small, the 

baseline’s ambiguity of whole cycles can’t be fixed. 

 

2. Baseline processing 

 

Figure 5-3-4 Project Plot 

After setting, right click Process to start the solution. When it is done, the project plot will display 

the dynamic trajectory. It can be hidden by clicking  button. 

3. Report Export 

Click Report., there will be a report of the dynamic solution. 
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Figure 5-3-5 Report 

5.3.2 PPK Dynamic Baseline Processing  

1. Baseline processing settings 

In baseline list, select a dynamic baseline, and right-click Process Options for settings. 

 

Figure 5-3-6 Settings 
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2. Baseline processing 

When finished settings, click Process to start the baseline solution. In this part, green points 

represent the RTK fixed solution, and yellow points represent the RTK float solution.  

 

Figure 5-3-7 Project Plot 

After finishing the solution, the project plot will display the dynamic trajectory line. It can be 

hidden by clicking  button. 

3. Report Export 

Right-click and choose Report to check the dynamic solution. The fixed solution means 

qualified, and unqualified solution results are red. 
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Figure 5-3-8 Report
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Network Adjustment 

 

This chapter contains:  

 

■   Steps of Network Adjustment 

■   Preparation of Network Adjustment 

■   Process of Network Adjustment 

■   Network Adjustment Examination 
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After the baseline vector processing, the user usually needs to further test the baseline processing 

result, optimize it and transform it to the required national or local coordinates, which is the 

content of the network adjustment. The method of this software network adjustment is the Least 

Squares Method.  

 

6.1 Steps of Network Adjustment 

The software has the functions of free net adjustment, 3D constrained adjustment, 2D constrained 

adjustment and height fitting.  

The basic steps of HGO data processing software for network adjustment can actually be divided 

into three parts, as can be seen from Figure 6-1-1:  

1. The preliminary preparation is done by users. It means to set up the coordinate, load the 

information of control points before network adjustment. 

2. The process of network adjustment is done automatically by the software. 

3. The quality analysis and control of the processing result. It requires the user to analyze the 

process. 
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Figure 6-1-1 Network Adjustment Process 

This shows that the software only realizes the calculation of the network adjustment. The more 

important is that the user participates and makes correct judgments. It should be noted that this 

is usually an interactive process. 

 

 

Form GPS baseline vectors net by extracting baseline vector 

3D no constrained adjustment 

3D 

Quality analysis and control 

2D Level fitting 

Coordinate and network adjustment setting  

Input fixed point coordinate as BLH, XYZ, NEH 

Network text 
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6.2 Preparation of Network Adjustment 

6.2.1 Coordinate Setting 

Check the settings of the coordinates before setting up the network adjustment. Normally, the 

coordinate ellipsoid selected by the domestic user is Beijing 54. The user needs to set up the 

central meridian, the additive constants in the x and y directions and so on.  

The setting of coordinates can be performed in the Coordinate Parameter of the Navigation bar.  

 

Figure 6-2-1 Coordinate Parameter 

When a user installs the software, the ellipsoid parameter of Beijing 54 has been set into the 

software and when creating a new project, the user usually has inputted the coordinate parameter. 

So, setting the coordinates before network adjustment is to check the coordinate parameters. 
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For the setting of the coordinate system, please refer to the relevant information. 

6.2.2 Network Adjustment Setting 

Choose Adjust → Adjust Options menu, here will be a dialog like Figure 6-2-2, we can set and 

test parameters of the adjustment.  

 

Figure 6-2-2 Adjust Options 

6.2.3 Control Points Information 

After the network adjustment settings, we need to input control points information. Otherwise, 
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the constraint adjustment won’t be performed. There are several methods to enter control point 

information: 

1. Click on Set as Control Point in the right-click menu of sites list, to set the site into control 

point.  

2. Click on Add Control Point in the right-click menu of control point list to enter the control 

point info.  

3. Click on Import Control Point File, in the right-click menu of control point list, to import the 

existing control point file to the project.  

After entering control point info, click on Save to Control Point File in the pop-up menu of 

control point list, to save as the individual file for next time.  

 

Figure 6-2-3 Control Point 
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6.3 Process of Network Adjustment 

Click Adjust in the Adjust menu, the network adjustment tool will appear.  

 

Figure 6-3-1 Network Adjust 

Generally, just click Auto Adjust, the software can start adjustment based on the known baseline 

processing result and form the results list. Select one of the results and click on Get Report to 

view the corresponding report.  

6.3.1 Get Baseline Vector Network 

The first step of network adjustment is to get a baseline vector network. The principle to form 

the baseline vector network is as the following:  

1. This baseline is in the project and must not be deleted; 
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2. This baseline is with the starting point name and calculating point name;  

3. This baseline has been calculated and qualified in the baseline vector list; 

4. This baseline isn’t disabled.  

All the baselines that satisfy the above four conditions will be loaded automatically in the first 

step of network adjustment, to form the baseline vector network.  

6.3.2 Connectivity Test of Baseline Vector Network  

If process adjustment is done without the network connected, the network adjustment result 

won’t converge. So, the software will test automatically the connectivity of the baseline vector 

network before processing. If the network isn’t connected, a prompt will appear. Please check 

the baselines that form the vector network, the observation station’s name and so on. The steps 

to check are the following:  

1. Check if the network is divided into several parts, or whether there is an isolated observation 

station or baseline. If so, delete the isolated points or separated parts to enable process adjustment; 

2. Check if the critical baseline has been calculated unsuccessfully, or prohibited from 

participating in the network adjustment. If so, re-process it, or even re-observe it; 

3. Check if there is the same observation station with different names. If so, the network will 

show that there is another station very close to the same station. These two stations can’t form 

any baseline to make the network connected because they are same site at different time spans. 
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The solution is to modify the error station name in the observation’s property.  

6.3.3 Adjustment Report 

The adjustment report contains the results, and its output items and report format can be set in 

the Adjust Report Options (Figure 6-3-2) Taking the free network adjustment as an example, the 

web version of the adjustment result is as Figure 6-3-3:  

 

Figure 6-3-2 Adjust Report Options 
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Figure 6-3-3 Adjustment Report 

 

6.4 Adjustment Results Examination 

After the network adjustment, the result should be checked. The result test is mainly evaluated 

by correction, mean square error and corresponding mathematical statistics test results.  

The mathematical statistics test of network adjustment includes the 2 test and TAU Test. The 

2 test shows the reliability of the adjustment result. If the test value is smaller than the 

theoretical range, the error of adjustment result is smaller than the theoretical error, which means 

that it’s better than the imagination. At this point, there is no need to process or select appropriate 

Coefficient of baseline Std. Dev (Relaxation factor) to pass the 2 test. If the test value is bigger 

than the theoretical range, it means that the error of adjustment result exceeds the allowable range. 









Network Adjustment 

 98 

It could be caused by excessive error in the baseline calculation, or gross error in the control 

point information. It is necessary to find the problem baseline or control point to fix and re-

calculate it until it passes the test. 

Tau test is used to check the existence of gross error in the baseline involving adjustment. 

Generally, the test result depends on the correction of each baseline after adjustment. If a baseline 

can’t pass the TAU Test, it needs to be re-calculated and re-participated in the adjustment, or to 

be prohibited.  

 

Figure 6-3-4 Result Tests 

If the result of network adjustment fails to pass the test, it is necessary to find the reasons from 

the following aspects:  

1. Check if the coordinate setting or others is correct. 

2. Check if the control points are correct and in the same coordinate system. 

3. Check if the baseline vector network is correct. For an unqualified static baseline, it can be 
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prohibited from participating in the network adjustment. If this baseline can’t be deleted or is 

very important in baseline network, it should be re-calculated. If necessary, make the field-work 

observation again.  

4. Check if the observation station and antenna height in the observation files are correct. If not, 

the closed error or free network adjustment results is very poor. 

It is acceptable to delete the poor quality observations. When adjusting, deleting the repeat 

baseline won’t affect the adjustment structure and the result will meet the requirements as well.  

Generally, if the network and the calculation of baseline are qualified, these two tests can be 

passed and 3D unconstraint adjustment can be done successfully. 
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This chapter contains:  

 Files Import 

 Data Files Export 

 Project Result Export 

 Baseline Result Export 

 Hi-Survey Project Result Export 
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From the above chapters, it is obvious that the HGO Software has a strong function but simple 

operation. In this chapter, we will introduce import and export of the software. 

The HGO data processing software has rich import and export functions, including import files, 

control point files, Stop&GO RSP files, and export of data files, baseline results, and project 

reports. 

 

7.1 File Import 

Import files through Import in the navigation bar and Import in the File menu. 

 

Figure 7-1-1 Import 

 

7.1.1 Data File Import 

Click Import to bring up the Import window. HGO software supports the import of static files 
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(*.ZHD, *.GNS), Rinex files, and SP3 ephemeris files. 

- Select Files (S): Import single or multiple data files. 

- Select Folder (F): Import all data files under the selected folder. 

 

Figure 7-1-2 Import 

7.1.2 Hi-Survey Project Import 

 

Figure 7-1-3 Interface of Import 

After selecting the corresponding Hi-Survey project, HGO loads and displays the Hi-Survey 

project information as follows: 
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Figure 7-1-4 RTK Field Data 

After the user clicks CSV or HTML, HGO can get the Hi-Survey project information. 

7.1.3 Control Point File Import 

Click Control Point File to bring up the Control Point File window. HGO software supports 

four types of control point files. Select the control point file format in the window, click OK. 

 

Figure 7-1-5 Control Point File 
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7.1.4 Stop&GO RSP Files Import 

Select an imported obs file, and then click Stop&GO RSP File to select the file to be imported 

in the pop-up dialog box. 

If the obs file is not selected, click the Stop&GO RSP File, and a prompt dialog box will pop up. 

 

Figure 7-1-6 Notice 

 

7.2 Observation File Export 

Normally, when you submit your results, some of the output is sorted out and submitted as part 

of the results. HGO software provides a wealth of results export functions, including obs file, 

baseline result, and project report export. 

 

Figure 7-2-1 Export 
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7.2.1 RINEX File Export 

Select RINEX File, click Setting to bring up RINEX Options dialog box, where the version, the 

satellites system, the export content, the interval, the start and stop time, the antenna height type 

can be set. After the setting is completed, click OK to return to the Export interface. 

 

Figure 7-2-2 RINEX Options 

For the imported raw data, select the observation files in the file list, click Convert to Rinex in 

the right-click menu to convert; and also select Folder from Export-Obs File to perform batch 

conversion; the results will be located in the Rinex folder under the project folder. 
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Notice: The part of the Hi-Survey instrument is certified by the NGS antenna 

and has accurate antenna phase center correction parameters. HGO software 

has built-in parameters to automatically correct when solving. For the old 

HDS2003 and other manufacturers' data processing software, if the 

instrument phase center correction parameters are not built in, the antenna 

height type setting must be set to the antenna phase center. 

7.2.2 Point Coordinate File Export 

Select Point Coordinate CSV File or Point Coordinate Text File, click Setting to bring up the 

Options window, where the exported content can be outputted, including the name, the code, 

WGS84-BLH and the Grid-NEZ. After the setting is completed, click OK to return to the Export 

interface. 

 

Figure 7-2-3 Options 
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Execute in Export→ Point Coordinate CSV File / Point Coordinate Text File→OK, select the 

source of the point coordinate file to be exported in "Source of Point Coordinates", and click OK 

in CSV format, or in text format to output the selected result information of each site. 

HGO software supports the result output of the Project stations, free 3D NetAdjust Result, 

WGS84 Result, Target System Result and Constraint 2D NetAdjust in Target System Result. 

 

Figure 7-2-4 Source of Point Coordinates 

The exported results are separated by commas in the format: 

Name of points, B, L, H, N, E, U 

 

Figure 7-2-5 Results 
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Notice: The result format can be directly used in the parameter solving tool 

software as an import file. 

7.2.3 Project Plot DXF Export  

Select Project Plot DXF, click Setting to bring up the Options dialog box, choose whether or not 

to output the result Include “Go” points if “Stop&GO” Processing. After the setting is 

completed, click OK to return to the Export interface. 

 

Figure 7-2-6 Options 

Execute in Export→Project Plot DXF→OK, select the source of the point coordinate file to be 

exported in Source of Point Coordinates, and click OK to output the DXF file; the result is 

located in the project folder, the "Plot.dxf" file in the Report directory. Open with CAD software 

as follows: 
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 Figure 7-2-7 Display in CAD 

Notice: If the graphics with CAD software can’t be seen, the angle of view 

needs to be adjusted. Please enter the commands e, z in the CAD software to 

automatically zoom the graphics to the effective view area. 

7.2.4 Control Point File Export  

Execute in Export→Control Point File→OK, select the format of the control point file in Control 

Point File, and click OK to output the control point file. 

 

7.3 Project Result Report Export  

Select Project Result Report, click Setting, and the Project report option dialog box will pop up, 

customize the content to be output in the Word report. After the setting is completed, click OK 

to return to the Export interface. 
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Figure 7-3-1 Project Report Option 

Execute in Export→ Project Result Report, select the format of the project report, click OK to 

output the file. It can output the project reports in three forms: TXT, DOC, and HTML, as well 

as the Repeat Baseline and Closed Loop Result report. 

The observation data list window, the baseline vector list window, and the observation site list 

window in the main program can print out the output project summary report, which we will not 

introduce here. 

 

Figure 7-3-2 Project Report 
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7.4 Baseline Result Export  

In order to exchange baseline data with other data processing software, we can export the 

baseline results to Trimble Data Exchange (for the adjustment data of Power Adj software), or 

Cosa Data Exchange (COSA); after selecting the format, click OK. 

 

Figure 7-4-1 Baseline Result 

The Trimble Data Exchange file is located in the BaselineResult_TGO.asc file under the Report 

directory of the project folder. 

 

Figure 7-4-2 BaselineResult_TGO.asc 
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The Cosa Data Exchange file is located in the BaselineResult_COSA.txt file under the Report 

directory of the project folder: 

 

Figure 7-4-3 BaselineResult_COSA.txt 

7.5 Hi-Survey Project Result Export 

After importing the Hi-Survey Project, when the PPK dynamic solution is not performed, the 

project result can be exported by CSV and HTML: 

 

Figure 7-5-1 Project Result 
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After importing the Hi-Survey Project, when the PPK dynamic solution is performed, we can 

export the project result replaced by the PPK solution through the toolbar Export: 

 

Figure 7-5-2 Hi-Survey Project Result 

 

Figure 7-5-3 Hi-Survey Project Result 
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This chapter contains: 

 

■   Antenna Manager 

■   Coordinate Transformation Tool 

■   Star Report 

■   SP3 Gate 

■   Rinex Convert Tool 
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8.1 Antenna Manager 

The antenna manager is designed for updating and editing the receiver parameter file (the 

HitAnt.ini file). When users apply the unknown receiver and know its geometric parameter and 

phase center height parameters, then add the needed receiver through this tool. 

Choose Tools → Receivers in the software menu, there will be pop-up window shown in Figure 

8-1-1. This window shows the relevant parameters of used antenna, such as radios, phase center 

height.  

 

Figure 8-1-1 Receivers 

In the window, choose the antenna name and can change directly the corresponding parameter.  

Notice: This document will influence the data result. Please don’t change it 

without thought! 
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8.2 Coordinate Transformation Tool 

The HGO supplies the coordinate transformation tool. Choose Tools → Coord Tool in the 

software menu to start the tool.  

This tool can transform between the local coordinate and the WGS-84 coordinate and has the 

function of solving parameters. Description of this tool are as follows. 

8.2.1 Overview 

First of all, it’s necessary to figure out the representation method of several coordinates. There 

are three common coordinate representations: Geodetic (BLH), Cartesian (XYZ) and Grid 

(xyh/NEU). The ellipsoid height is a geometrical quantity, and the levelling height is a physical 

quantity.  

The WGS-84 coordinate is based on the longitude, latitude and ellipsoid model; while Beijing 

54 coordinates adopt the description of plane coordinates and leveling height. 

Now it comes to rigor issues of the transformation. In the same ellipsoid, the geometrical 

transformation is strict (BLH<—>XYZ). But the transformation in the different ellipsoid is not 

strict. For example, there isn’t a method that can be used universally for the transformation 

between WGS-84 and Beijing 54. Because the first one is the geocentric coordinate system and 

the second one is the ellipsoid-centered coordinate system. The elevation’s transformation is 

between geoidal height and physical quantity. Therefore, local fitting must be performed with an 
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ellipsoid in each place, usually with the Bursa-Wolf Parameters model.  

So, what should be the transformation between the different ellipsoids? Generally, the more  

strict model is the Bursa-Wolf. That is the X plane, Y plane, Z plane, X spin, Y spin, Z spin and 

scale dilution K. For these seven parameters, it is necessary to have more than three known 

points in a location. (At least seven equations can be solved for Bursa-Wolf formula, so three 

points are needed to list nine equations.) If the area is not large and the distance between the 

farthest points is within 30km (empirical value), it’s acceptable to use the three parameters 

model, which means X plane, Y plane, Z plane. The X spin, Y spin, Z spin and scale dilution K 

are regarded as zero. So this model is the special case of the Bursa-Wolf model.  

The essence of the seven parameters model is to fit the shape of local coordinates with a local 

ellipsoid. So, after the transformation, the local ellipsoid height obtained is the leveling height. 

Of course, plane and elevation can be fitted separately. For example, fit the plane with a 

2D+Helmert model and fit the elevation with a quadric surface model and others. This mode of 

handling separately confers more freedom than the Bursa-Wolf model. However, this is only 

used for small regional coordinate transformations, because of the fewer parameters and weaker 

expression ability of the 2D+Helmert model.  

In summary, the HGO coordinate transformation tool provides two methods for customers to 

choose: 

1. Bursa-Wolf model, to get local plane and level data in one step.  

2. 2D+Helmert model and elevation fitting model, to get local plane and level data in two steps.  
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Since the model and process definition of each manufacturer may be different, below is the 

transformation process. 

1. The process of Bursa-Wolf model 

 

Figure 8-2-1 Bursa-Wolf Model Process 
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2. The process of the 2D+Helmert model 

 

Figure 8-2-2 2D+Helmert Model Process 

3. The process of elevation fitting: 

 

Figure 8-2-3 Elevation Fitting Process 
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8.2.2 Use Software to Transform Coordinates 

The software manages the coordinate transformation parameters as a file. Users can save the 

defined settings of transformation parameters as a file (*.dam) and open this file to transfer all 

the saved parameters for the next use.  

The parameters involved in the coordinate transformation refer to the ellipsoid parameter, 

projection parameter, seven parameters, four parameters, elevation fitting parameter and level 

grid files. All of these parameters are integrated into the following window (like figure 8-2-4) 

for input. After the input, take a name for the file and click on Save to create a “*.dam” parameter 

file in the GeoPath directory under the Program folder. 

Click on Tool →Coord Tool → Parameter. 

 

Figure 8-2-4 Parameter 
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Input the parameters in the window or click on Add Predefined to use the saved coordinate 

transformation files, then click on OK to return to the main surface for the direct and inverse 

calculation of coordinate:  

 

Figure 8-2-5 Transform Coordinate 

8.2.3 Parameter Calculation 

When users have a group of control points (these points have the WGS-84 coordinate and local 

coordinate), the software can be used to solve the parameters. As mentioned above, the software 

provides the Bursa-Wolf model and 2D+Helmert model and elevation-fitting model solution that 

can completed in the same interface. It’s convenient for users to compare and choose different 

precision models. In the main interface of Coord Tool, click on Tools → Parameter Calc to open 

the parameter calculation interface (if the ellipsoid and projective parameters are not entered, the 

Parameter interface will be prompted and pop up).   
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Figure 8-2-6 Parameter Calculation 

The process of parameter calculation is: 

1. Input the basic parameters: local ellipsoid and projection parameters. 

2. Import data: add the points coordinate one by one or prepare the text file and click on Add 

Predefined (notes: the file format is: Name,B,L,H,N,E,U). 

3. Calculate parameter: the software supports two coordinate transformation models. Click on 

Calc Bursa Parameter or Calc Helmert 2D + Height. If you use the second model, please select 

the elevation fitting model first.   

4. Check the results: the calculated parameter will be output in the result bar and you can copy 

out to save them. 
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5. Use parameters: click on Parameter settings to check the transformation parameter, ellipsoid 

parameter and projection parameters. After confirmation, name and save it as “*.dam” file for 

use in other Hi-Target software.  

Notice: Please switch to the Map interface to check the geometric distribution 

of the starting point (avoiding the linear distribution that leads to instability 

and poor applicability of parameters). 

 

8.3 Star Report 

The HGO supplies the satellite prediction software. Click on Tool→ Star Report to open it.  

The satellite prediction is based on the satellite almanac data, received by the GPS receiver, and 

reports to the users the satellite distribution in a specific location and period in the future. 

Therefore, it is planned to select a suitable time for GPS field data acquisition, so as to improve 

the efficiency of the field work and data utilization. 

The steps of the star report tool are follows: 

1. Update historical data; 

2. Set station position and time, elevation mask. 

3. Conduct the forecasting, check the satellite number and DOP value and choose the observation 

time.  
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8.3.1 Input Almanac Data 

Star report requires software to load the recent almanac data. The program will use the 

information of satellite orbits recorded in the almanac data to calculate the satellite position. The 

almanac data is generally in YUMA format, and the ephemeris file can be downloaded in the 

Status window.  

 

Figure 8-3-1 Ephemeris File 

8.3.2 Setting of Coordinate and Time Zone 

After loading the almanac data, set the station BL, Height, elevation mask, observation time and 

so on, which will be used to calculation.  

Set the date in the Status window. The default date is the computer system time. The user can 

select any day by clicking Pre, Today, Next or Manual.  



HGO User Manual  

125 

 

Figure 8-3-2 Status 

Click Options in Navigation bar to set the BL, height, elevation mask and observation time.  

 

Figure 8-3-3 Time Zone 
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Longitude and latitude generally do not need to be very precise, and about one or two kilometers 

of precision can be acceptable.  

If users do not know their latitude and longitude, the following methods can be used: 

With the included coordinate transformation software, the user can convert the known standard 

rectangular coordinates into latitude and longitude system, and then input them into the software 

for star report.  

Get the BLH format coordinate by specific GPS instruments such as V90 Plus and iRTK5. 

 

Figure 8-3-4 Ephemeris 

When setting the time, please pay attention to the local time and GPS time. When inputting the 

observation period in local time setting, confirm the time difference between local time and UTC 

time. Usually, when installing the operating system, the computer will prompt to select the time 
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zone. For example, Beijing time is 8 hours earlier than UTC time (International Standard Time). 

If the local time method isn’t used, the software defaults that the input time is Beijing time.  

Generally, when setting the observation period, the difference between the start time and the end 

time is several hours to 24 hours while the start time is always ahead of the end time.  

 

Figure 8-3-5 Instrument Setting 

The elevation mask controls the azimuths of the forecasting satellite, and only the satellite that 

exceed the setting azimuths will be displayed. Sampling rate controls the time interval of the text 

output. The lower the sampling rate, the more detailed the output data are.  

8.3.3 Star Report Status 

After inputting the observation station and period and clicking on OK, the status of the star can 

be seen in the software.  
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1. Satellite detail textout 

 

Figure 8-3-6 Satellite Detail Textout 

2. Satellite time plot 

Satellite time plot shows the change of the number of the visible satellites, with the time elapsing 

in the limited period. The abscissa is the span of time and the ordinate is the number of the 

satellite. According to the time plot, it is possible to select the planned observation time in which 

the number of satellites is relatively enough to conduct a higher-accuracy fieldwork 

measurement.  
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Figure 8-3-7 Satellite Time Map 
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3. Satellite track plot 

Satellite track plot shows the distribution and movement of satellites at a certain time, in a certain 

area. Since GPS satellites are always in motion, we use visual satellite plot to represent the 

number of visible satellites in the sky at the observation time. The visible satellites number is 

closely related to the elevation mask. From Figure 8-15, the Satellite 26 travels from north to 

south and the Satellite 10 will rise in the sky in the southeast during the observation process. The 

plot shows the BL coordinate as well as the observing period.  

The direction displayed by this view is the same as maps which the north points to the up and 

the east points to the left. As shown in figure, the outermost circle represents the ground plane, 

the two dotted circles indicate that the cutoff angle is 60 degrees and 30 degrees, and the center 

of the circle represents the zenith.  

The satellite distribution at half an hour intervals in the segment can be seen by pulling the time 

slider in the Status window.  

 

Figure 8-3-8 Satellite Track Map 
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4. Number of the visible satellites 

The number of the visible satellites are expressed in a rectangular coordinate that counts the 

visible satellites in the given period and represents visually the relationship between star numbers 

and time.  

 

Figure 8-3-9 Number of the visible satellites 

5. Position dilution of precision 

Position Dilution of Precision (PDOP) denotes the influence of the satellites’ distribution on the 

positioning accuracy. In some cases, more visible satellites don’t mean better positioning 

accuracy. Generally, when the PDOP value is less than 4, the observation result is considered to 

be reliable.  

 

Figure 8-3-10 Position Dilution of Precision 
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6. World plot 

The trajectories of satellites can be seen in the world plot and the distribution in current time 

which be adjusted by the slider button in status tab. When viewing the world plot, just select 

the GPS and BDS system. 

 

Figure 8-3-11 World Map 

7. Print preview 

Textout, number of satellites, PDOP value, and satellite sky distribution can be printed out 

through print preview and print functions. 

8. Hole plot 

The satellite Hole Map indicates that the area receives too few satellites to collect data. 

8.3.4 Update Almanac Data 

For accurate satellite forecasting, the almanac should be updated frequently. It is generally 

recommended that users do not use the calendar for more than one month. The software will 
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prompt for outdated data and limit its usage.  

8.4 SP3 Gate 

SP3 Gate can provide users with precise satellite orbit and clock error files issued by IGS. 

Click Tool → SP3 Gate, the window like Figure 8-19 will be displayed. Users can download the 

precise ephemeris needed with a simple configuration.  

The steps of using SP3 Gate include: 

1. Set the Date Span; 

2. Set the folder to save; 

3. Set the FTP Server to download (some sites may not be available).  

4. Set the type of the ephemeris (Ultra rapid, Rapid SP3, Final SP3) 

5. Click Star to download.  

 

Figure 8-4-1 SP3 Gate 
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8.5 Rinex Convert Tool 

Rinex convert tool can convert the static data collected by the Hi-Target receiver to the Rinex 

file. Click Tool → RINEX Convert Tool, a window like Figure 8-5-1 will be displayed.  

 

Figure 8-5-1 Convert Rinex 

This tool is identical to the Rinex conversion settings and functions of the HGO main interface, 

so that won’t be covered again here. After setting the configuration item, click Convert to 

complete the work. 

The HGO tools include Antenna Manager, Star Report, Coordinate Transformation, SP3 Gate, 

Rinex Convert and so on. This chapter focuses on how to use these tools and how to deal with 

frequently asked problems. When installing HGO software, select all the installations and these 

tools will be installed in the “Bin” directory of the software and provide shortcuts.
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9.1 Terminology Notes 

1. IGS 

International GPS Service (IGS), based on the global ground-based GPS continuous operation 

station, is an example of GPS continuous operation network and comprehensive service system. 

It provides GPS users with various free information, such as GPS precise ephemeris, fast 

ephemeris, forecast ephemeris, IGS station coordinates and their motion rate, phase and pseud-

orange data of GPS signals received by IGS stations, and earth rotation rate. It supports countless 

scientific projects in geodesy and geodynamics, including ionosphere, meteorology, reference 

frames, precise time transfer, high-resolution Estimate of Earth's rotation rate and its changes, 

and crustal movement. DORIS in France and PRARE in Germany are also considering the 

establishment of similar international organizations to make sure such space geodetic 

observation system are more efficient, automated, accurate and reliable. 

2. Ambiguity 

The unknown integer number of cycles of the reconstructed carrier phase contained in an 

unbroken set of measurements from a single satellite pass at a single receiver. 

3. Baseline 

The length of the three-dimensional vector between a pair of stations for which simultaneous 

GPS data has been collected and processed with differential techniques.  
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4. Broadcast Ephemeris 

Satellite orbital parameters obtained by demodulation in a message published by a satellite. 

5. SNR (Signal-to-noise Ratio) 

The ratio of signal power to noise power at an endpoint. 

6. Cycle Slip 

A phenomenon under the interference, the loop jumps from a balance point for several cycle and 

stabilizes at a new equilibrium point, causing the integer period of phase to produce an error. 

7. Carrier Wave  

A radio wave having at least one characteristic (e.g., frequency, amplitude, phase) which may be 

varied from a known reference value by modulation.  

8. C/A Code 

The Coarse/Acquisition GPS code modulanted on the GPS L1 signal. This code is a sequence of 

1203 pseudorandom binary biphase modulations on the GPS carrier at a chipping rate of 1.023 

MHz, thus having a code repetition period of one millisecond. 

9. Difference Measurement 

GPS measurements can be differenced across receivers, across satellites and across time. 

Although many combinations are possible, the present convention for GPS phase measurement 

differencing is to perform the differences in the above order: first across receivers, second across 
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satellites and third across time. 

- Single difference measurement (across receivers) is the instantaneous difference in phase of a 

received signal, measured by two receivers simultaneously observing one satellite. 

- Double difference measurement (across receivers and satellites) is obtained by differencing the 

single difference for one satellite with respect to the corresponding single difference for a chosen 

reference satellite. 

- Triple difference measurement (across receivers, satellites and time) is the difference between 

a double difference at one epoch of time and the same double difference at another epoch of time.  

10. Difference Positioning 

Determination of relative coordinates between two or more receivers which are simultaneously 

tracking the same GPS signals.  

11. Geometric Dilution of Precision 

In dynamic positioning, a factor describing the contribution of satellite geometry position to error. 

Expression: 
 DOP tr Q QT

1

. Where Q is the matrix factor of the instantaneous dynamic 

position solution (depending on the location of the receiver and satellite). 
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Table 9-1-1 Several Standard Terms in GPS 

Name Meaning 

GDOP 4-D geometric factor 

PDOP 3-D coordinate geometric factor 

HDOP 2-D coordinate geometric factor 

VDOP Elevation geometric factor 

TDOP Clock difference factor 1:40,000 

HTDOP Elevation and clock difference geometric factor 

12. Dynamic positioning 

A method determining the coordinate of the moving rover changed with time.  

Each measurement result is obtained from a single data sample and calculated in real time. 

13. Eccentricity 

2

22

b

ba
e




 

a: semi-major axis  

b: semi-minor axis. 

14. Ellipsoid 

In geodesy, a mathematical figure formed by revolving an ellipse about its minor axis. Two 
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quantities define an ellipsoid; these are usually given as the length of the semi-major axis a and 

the flattening f. 
 ba

a
f 

1

 

15. Ephemeris 

The energetic parameters of the position of a celestial body with time. 

16. Flattening 

Relating to Ellipsoids 

   211
1

eba
a

f 
 

a: semi-major axis; b: semi-minor axis.; e: eccentricity 

17. Geoid 

The particular equipotential surface which coincides with mean sea level, and which may be 

imagined to extend through the continents. This surface is always perpendicular to the direction 

of the force of gravity. 

18. Ionosphere Delay 

A wave propagating through the ionosphere (which is a non-homogeneous and dispersive 

medium) experiences delay. Phase delay depends on electron content and affects carrier signals. 

Group delay depends on dispersion in the ionosphere as well and affects signal modulation 
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(codes). The phase and group delay are of the same magnitude but opposite sign. 

19. L-band 

The radio frequency band extending from 390 MHz to 1550 MHz.  

20. Multipath Error 

A positioning error resulting from interference between radio waves which have travelled 

between the transmitter and the receiver by two paths of different electrical lengths. 

21. Observing Session 

A period of time for collecting GPS data simultaneously using more than two receivers 

22. Pseudo Range 

A measure of the apparent signal propagation time from the satellite to the receiver antenna, 

scaled into distance by the speed of light. The apparent propagation time is the difference 

between the time of signal reception (measured in the receiver time frame) and the time of 

emission (measured in the satellite time frame).  

23. Receiver Channel 

The Radio, Mixing and Intermediate frequency channel in the GPS receiver which can receive 

and track the two carrier frequency signals of the satellite. 

24. Satellite Configuration 

The state of the satellite constellation at a specific time, relative to a specific user or set of users. 
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25. Static Position 

The measurement of point position, without taking into account the motion of the receiver.    

26. Universal Time 

Local solar mean time at Greenwich Meridian. 

UT: Abbreviation for universal time UT0. 

UT0: As deduced directly from observation of stars. 

UT1: UT0 corrected for polar motion. 

UT2: UT1 corrected for seasonal variations in the Earth’s rotation rate. 

UTC: Universal Time Coordinated; uniform atomic time system kept very close to UT2 by 

offsets. 

27. Interval 

The process of taking a continuous variable value at periodic intervals. 

28. Condition of Observation 

The geometric figure and trajectory of the satellite constellation. 

 

9.2 RINEX Format Description 

9.2.1 Observation Data File 

This file contains header blocks and data blocks. Figure 9-2-1 lists the header blocks for this file 
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and figure 9-2-2 lists the data blocks for this file. Here are just a few of the nouns in the 

observations. 

1. Time: Refers to measuring time which signal arrives at the receiver 

2. Pseudo range: Measurement of the apparent signal propagation time from the satellite to the 

receiver antenna, scaled into distance by the speed of light. In RINEX, there are three kinds of 

pseudo range observations: C1 is L1's C/A code, P1 is L1's P code and P2 is L2's P code. Because 

of the AS policy, many receivers cannot get the P code of L2, instead of that, adopting the related 

technology to find out the Y2-Y1 time delay to eliminate ionosphere influence. In this case, in 

RINEX, the time delay between C/A code and Y2-Y1 is converted to the synthesized P2 code. 

3. Phase: It is a small value over the entire week of the beat frequency at the L1 and L2 

frequencies. When the square technique extracts the phase, it is a small value in half a week and 

must be converted to an entire week. 

4. Doppler: The receiver uses a specific processing software to record the Doppler value D1 and 

D2 and take Hz as the unit. 

In all above records, the three observations must be consistent in time. If the external frequency 

standard is used to correct and set the time error correction number as τ, the following 

measurements are as follows: 

ρ(corr)＝ρ(recv)－c×τ 
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T(corr)＝T(recv)－τ 

L1(corr)＝L1(recv)－F×τ 

Figure 9-2-1 Description of Navigation File Header Block 

Header Name 

61～80 Columns 

Description Format 

RINEX VERSION/TYPE Version format (2) 

File type O——Observation data 

Positioning system G——GPS 

                R——GLONASS 

                M——MIXED 

16, 14X 

A1, 19X 

A1, 19X 

PGM / RUN BY / DATE Name of file outline  

Name of file institution  

Date of document creation  

A20, 

A20, 

A20 

COMMENT Comments A60 

MARKER  NAME The name of measuring point A60 

MARKER  NUMBER The number of measuring point A20 

OBSERVER / AGENCY Name or agency of the observer A20, A40 

REC# / TYPE / VERS Receiver number, model and software 

version 

3A20 

ANT# / TYPE Number and type of antenna 2A20 

APPROX POSITION 

XYZ 

Approximate position XYZ 3F14.4 
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ANTENNA: DELTA 

H/E/N 

Antenna height H 

Eastward eccentricity of antenna E 

Westward eccentricity of antenna N 

3F14.4 

WAVELENGTH  FACT 

L1/2 

Wavelength factors of L1/L2 

  1: Integer ambiguity 

  2: Semi-cycle ambiguity 

  0: L1 Single frequency 

Number of tracking satellites (maximum 7, 

more than 7 duplicate records) 

PRN Satellite number 

2I6 

 

 

 

I6 

7(3X,A1,12) 

# / TYPES OF OBSERV The number of different observation types 

in the file 

Definition of observation type: 

L1, L2: L1, L2 phase observations(cycle) 

C1: C/A pseudo range measurements of L1 

(m) 

P1, P2: L1, L2 P code pseudo range 

measurement (m) 

D1, D2: Doppler pseudo range 

measurement of L1 and L2 (Hz) 

T1, T2: The integral Doppler observation of 

meridian instrument (cycle)  

After the implementation of AS, L2 and P2 

are changed. 

I6 

9(4X,A2) 
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INTERVAL Interval of observation (s) I6 

TIME OF FIRST OBS Starting time of observation (year, month, 

day, hour, minute, second) 

Time system: GPS=GPS time system 

           GLO=UTC time system 

Default value in GPS/GLONASS: 

   GPS=plain GPS file 

   GLO=plain GLONASS file  

5I6，F12.6 

6X, A3 

TIME OF LAST OBS 

 

 

Ending time of observation (year, month, 

day, hour, minute, second) 

Time system: GPS=GPS time system 

           GLO=UTC time system 

Default value in GPS/GLONASS: 

           GPS=plain GPS file 

           GLO=plain GLONASS file 

5I6，F12.6 

6X,A3 

LEAP SECONDS In GPS/GLONASS, the slip second from 

January 6, 1980,  

I6 

#OF  SATELLITES The observation numbers of satellite 

contained in the document 

I6 

PRN / # OF OBS The satellite number. 

If more than 9 observables are measured, 

repeat the record 

3X, A1 ,I2,9I6 

6X，9I6 

END OF HEADER Header block terminator 60X 
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Figure 9-2-2 Description of Data Block of Observation File  

Observation Record Description Format 

EPOCH /SAT 

Or 

EVENT FLAG 

Epoch: year, month, day, hour, minute, second 

Epoch sign 0: Normal 

          1: Interruption of epoch 

         ≥1: Epoch flag 

The number of satellites in the current calendar 

The satellite number in the current epoch, if there 

are more than 12, then another line (A1, I2) 

Receiver clock (s) 

If there are more than 12 satellites, records 

continuously; 

If Epoch flag>1 

then Epoch sign: 

2: Start moving the antenna 

3: Placed at a new point, the end of the moving 

4：Header information 

5: Exception (the epoch is too large) 

6: The record of cycle slip 

The satellite numbers are recorded in both signs 

2 and 5. 

5I3, F11.7 

I3, 

 

 

I3 

I2(A1, I2) 

F12.9 

32X,12(A1, I2) 

OBSERVATIONS Observation date 

LLI 

m (F14.3, I1, I1) 
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Signal strength 

The above data for each satellite is recorded in 

EPOCH/SAT. If more than 5 observations (80 

byte), continue the next record. 

Observations： 

Phase: expressed as integer 

Pseudo range: expressed as meter 

Indicates that the measurement is lost 

LLI: Indicates the satellite lock status (0～7） 

Normal 

Default value 

AS exists 

Signal intensity 

1: Minimum signal intensity 

5: Moderate signal intensity 

9: Maximum signal intensity 

0: Do not consider 

9.2.2 Navigation Data File 

The satellite ephemeris is broadcast navigation message taken from the satellite, which is the 

basic data for calculating the ground position. 

In the navigation message, the number of orbits, the satellite clock parameter, etc. are included. 

In order to accelerate the calculation of the ground point, the satellite sends the broadcast 
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navigation message once per second, while the broadcast navigation message update every hour. 

So, each observation only needs to record a set of broadcast navigation messages. Figure 9-2-3 

and figure 9-2-4 list the navigation file header block and data block, representatively.  

Figure 9-2-3 Description of Navigation File Header Block 

Header Name 

61～80 Columns 

Description Format 

RINEX VERSION / TYPE Version format (2) 

File type (N——navigation data ) 

I6, 14X, 

A1, 19X 

PGM / RUN BY / DATE Name of file outline  

Name of file institution  

Date of document creation  

A20 

A20 

A20 

COMMENT Comments A60 

TON ALPHA Ionosphere parameters A0—A3 2X, 4D12.4 

ION BETA Ionosphere parameters B0—B3 2X, 4D12.4 

DELTA-UTC almanac parameters for calculating  

UTC time 

 

 

A0, A1,T,W A0, A1: Calculate the parameter of time 

correction  

T :   Reference time of UTC data 

W :  Reference weeks of UTC 

 

LEAP SECONDS Time variation due to leap seconds I6 

END OF HEADER Header block terminator 60X 
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Figure 9-2-4 Description of Navigation File Header Block 

Observation Record Description Format 

PRN /EPOCH / SV 

CLK 

PRN Satellite number 

Epoch: TOC——Time of clock 

Year (two digits); 

Month; 

Day; 

Hour; 

Minute; 

Second. 

Satellite clock error  (S) 

Satellite clock drift  (s/s) 

Rate of satellite clock drift  (s/s2) 

5I3, F11.7 

I3, 

 

 

I3 

I2(A1, I2) 

F12.9 

32X,12(A1,I2) 

BROADCAST 

ORBIT-1 

IODE Expiry date of ephemeris data  

Crs                           

(m) 

Δ n                          

(rad/s) 

M0                       

(rad) 

3X, 4D19.12 

BROADCAST 

ORBIT-2 

Cuc (rad) 

e  flattening 

Cus (rad) 

 ( ) 

 

A m



HGO User Manual  

151 

BROADCAST 

ORBIT-3 

Toe time of ephemeris 

Cic (rad) 

Ω  (rad) 

Cis (rad) 

3X,4D19.12 

BROADCAST 

ORBIT-4 

I  (rad) 

Crc (m) 

Ω  (rad) 

Ωdot (rad/m) 

3X,4D19.12 

BROADCAST 

ORBIT-5 

Idot (rad/s) 

L2 

TOE 

L2 P Data label 

3X,4D19.12 

BROADCAST 

ORBIT-6 

Satellite precision (m) 

Mobile Station Based (MSB) 

TGD (S) 

IDOC Expiry date of clock data  

3X,4D19.12 

BROADCAST 

ORBIT-6 

Message sending time (GPS week seconds 

- counting from the Z of the word HOW) 

3X,4D19.12 

 


